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Windows 7 (32-bit and 64-bit)
Windows 8 (32-bit and 64-bit) 
including Windows 8 Pro Tablets
Windows 10 (32-bit and 64-bit)

Supported Database Engines
Microsoft Access (2000 and
2002/2003)

SQL Server (2000, 2005, 2008, 
2012, 2014, 2016, and 2017)
Networkable1

MySQL (version 5)

Oracle (9i and 11g)

Microsoft Active Directory / LDAP

ODBC

Native Native,
Live Link

Native,
Live Link

Native, 
Live Link
X

Native,
Live Link

Native, 
Live Link
X

Live Link

Native,
Live Link
Live Link

Live Link

All Asure ID Editions

Native

Native

Native

7

1Getting started
The Asure ID® User Guide covers the basics of the Asure ID user interface, installation, and configuration. For a
more in-depth explanation of Asure ID, see the Asure ID Reference Guide (PLT-01797). This reference guide
can be downloaded from the HID Global® web site http://www.hidglobal.com/documents. 

1.1 Supported OS and database engines
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Supported Operating Systems

1. Asure ID site license enable sharing of networked database information on multiple workstations.

http://www.hidglobal.com/documents
http://www.hidglobal.com/documents
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1.3 Installation
The Asure ID installation files can be accessed in either of the following:

1.2 System requirements
1 GHz or faster processor

1 GB RAM

1 GB available hard disk space

Supported operating systems

The Asure ID CD. Insert the CD into the PC and follow the instructions. 

Note:If the CD does not run automatically, browse to the file.

Download the software from the HID Global web page, 

1.The Installation Wizard opens and starts the installation.

2.Select a language from the pull-down list, and click Next.

Note:To install the software in Indonesian you download/install the English version of Asure ID, then 
use the Change Language option to change the program to Indonesian. See Section 2 The 
Options window. 

3.Read and accept the License Agreement, and click Next.

4.Select a folder to install the software, and click Next.

5.When installation is complete, Set the Installation Options:

Activate Asure ID – With a license key you can activate the Asure ID software. If this option is not 
selected, Asure ID is installed with a 30-day trial license. See Section 1.3.2 Activate Asure ID.
Configure Native Data Source – Allows you to configure the native data source which stores card 
templates and Asure ID system information. By default Asure ID sets the native source to an 
embedded Microsoft Access data source.

Note:This option is recommended for installations where Asure ID is used on multiple PCs, where all 
template and reporting information needs to be consistent.

Automatically Check for Updates – Notifies you of product updates.

Setup.exe 

www.hidglobal.com/AsureID.

1.3.1 Installation wizard

http://www.hidglobal.com/products/software/asure-id
http://www.hidglobal.com/products/software/asure-id
http://www.hidglobal.com/products/software/asure-id
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6.Click Finish.
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1.3.2 Activate Asure ID
 is selected, Asure ID prompts you to enter the following information and the license key. 

The license key is located on the back of the CD case. 

1. Click or . 

Online activation requires an Internet connection.

2.Click .

If is selected, you are directed to call a provided number and provide this 
information to HID Global.

If Activate Asure ID

Note:

Phone Activation Activate Online

Note:

OK

Note: Phone Activation

Printer Model

AANNN-AAAANANA
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1.4 Initial login
1.Open Asure ID by double-clicking the Asure ID icon.

2.For Asure ID Express editions and above, enter:

User ID: admin 
Password: admin 
Note:Asure ID Solo users are not required to enter a user ID or password.

Note:To identify the Asure ID edition purchased, see the Licensing window (File > 

Licensing). The edition is displayed under the Asure ID section with the license key.

3.You can modify the Starting Application option if needed. 

4.Click OK.

 > 

If the software has not been activated the Activation Required window opens. Select a version of
Asure ID. Click Activate. For a 30 day trial version, click Continue.

Note:

Options
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1.5 Window layout of Asure ID
With each Application that is selected there is a corresponding set of tabs, tools and display screens. Each of
these Application windows are described in detail in the following sections.

 You can toggle between showing both sides of the card and either front or back. These 
views are only enabled if the card is dual-sided.

You can zoom in and out as well as set specific zoom levels.

 This side panel contains all the applications modules used to design, create and manage 
security issuance cards. See Section 1.5.1 Asure ID application modules.

When accessed, the data fields of the cards (Data Field tab) as well as Smart Chip 
Applications (iDIRECTOR� tab) are displayed.

The X/Y coordinates show the current position of the cursor. If rulers are displayed, 
the markers also show this position.
Card View & Zoom Controls

Current Cursor
Location

Applications:

Card Properties: 

Current Cursor Location: 

Card View:

Zoom Controls: 

Card Template

Card View &
Zoom Control

A
p

p
lic

at
io

ns
C

ard
 P

ro
p

erties
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1.5.1.3 Advanced

1.5.1.2 iCLASS SE encoder

1.5.1 Asure ID application modules

1.5.1.1 Home

User Config - 
Express

Laser Config - 

Note:

Note:

iCLASS SE Encoder 

Work Order Manager

Key Management

Reader Configuration

The 

Allows you to manage user privileges and login credentials for Asure ID Editions of 
and above.

Allows configuration of numerous laser settings.

With the Asure ID internal database, you can store card templates and cardholder information.

With Live Link, you can also print card data from external databases such as HR, security or ERP. The 
Live Link wizard sets up real time data exchanges with a few mouse clicks. At print time, Live Link 
accesses and delivers the data that populates the external data fields on each card. For detailed 
information on the Live Link, see the Asure ID Reference Guide (PLT-01797).

application allows you to create work instructions and embed them into a template.

Card Design enables you to create a card template for each card type (for example, employee card,
contractor or student). 

Data Entry allows you to add, modify, and delete card records, including acquiring photos and printing 
cards.
Reports allows you to view standard reports (for example, user activity and template activity reports) 
and custom reports.
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2The Options window
The Options window is available on every File tab, and allows you to manage the iCLASS SE® Encoder
Formats, Plugins, Database, Options, and User Options.
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2.1 Configurable options
The Options window has the following configurable sections. For detailed information on each option, see the
Asure ID Reference Guide (PLT-01797).

Language: Allows you to set the default language of the application.

Template: Allows you to set the basic template options for the Asure ID application.

Skins: Allows you to customize the look of the Asure ID application by selecting a predefined skin.

Resources: Allows you to access resource information for the application.

Printing: Allows you to define all of the printing options for the application.

Advanced Printing: This option is used to configure the printer chip encoding and magnetic encoding 
command sequences. The parameters auto-fill for the selected printer.

Encoding: Allows you to manage all the encoding settings within the printer.

Note:There is a desktop encoder available, that allows you to encode cards with a separate device.

Licensing: Allows you to view, modify, and activate the licensing information of the Asure ID 
application. 
Card Design: Allows you to set the Card Design default settings for the text labeling, field formatting 
and compound field formatting.
Devices: Allows you to select from available Photo and signature devices.

iCLASS SE Encoder: Allows you to modify iCLASS SE Encoder options on the Asure ID application. 

Note:This option has multiple tabs; Format, Plugins, Database, Options, and About.
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3Card Design application
The Asure ID Card Design application allows you to:

Lay out and design a card template.

Add technologies, including a barcode.

Personalize the work environment, including adding and removing grid lines and rulers as well as 
modifying the card view, orientation, zoom level and properties.
Link data fields to external data sources.

Save, edit and export work.

The application is used to create the card layout for printing and encoding. Each card layout is 
saved as a template for use by the application.

Card Design
Data Entry

Important:After the template is saved with the links to the data source, you cannot add additional fields. 
The existing fields can be modified, but if a new field is needed, a new template needs to be 
created. 
For detailed information on the Card Design application, see the Asure ID Reference Guide (PLT-01797).



18

Card Design application PLT-01485, Rev. 2.5

September 2018

3.1 Card Design overview

3.2 Basic Card Design tutorial
The tutorial walks through the process of creating a basic ID card. From this example, you should be able to
create their own templates, import data, and print cards.

The basic Card Design is as follows:

The  application has the following tabs, with a corresponding toolbar.

Additional capabilities, such as magstripes, barcodes and Smart Chips are covered in 
.

This tab allows you to perform template operations.

 This tab contains all the tools to create/modify a card template.

This tab displays the current card layout, and additional tools for card configuration.

This tab allows you to display and modify the current view.

Card Design

File:

Home:

Card Setup: 

View: 

Section 3.2.1 Create a template

Section 3.2.2 Add a text label (company name)

Section 3.2.3 Add a data field (employee number)

Section 3.2.5 Compound field (last name, first name)

Section 3.2.6 Add a photo

Section 3.2.8 Add image (logo)

Section 3.2.7 Add a signature

card design tutorial
Section 3.3 Advanced 
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3.2.1 Create a template
Note: Card Design

File New Template. 1.

For detailed information on 

Select Card Design applications > 

 see the 

tab > 

 (PLT-01797).Asure ID Reference Guide
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Note:The selected options are displayed in the 

4.Click OK. The new template opens in the display window.

 pane.

3.The window displays each step to create a new template. Set the following options:

2.Select Create New Template. 

Note:Selections are indicated with an orange background and selected options are displayed in the 
Card Properties pane.

Field
Select Card Size and Number of Sides

Select Card Orientation

Select Magstripe Properties

Select Technologies

Setting
Single Sided CR-80

Landscape None

None

Card Properties
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5.Select  tab > 

You can adjust the view displayed from the  tab options. 

. Enter a Name for the template and click 

6.The template name displays on the top of the window, and the card information and view controls are 
at the bottom of the window.

Note:

File Save Template

View

OK.



22

Card Design application

Define the field name and enter the text to display in this field.
Note:The Field Name should be a name that can be associated to the actual field text. 

Field Name: Enter Company Name
Field Text: Enter your company name (example is HID Global).

Set the font options. In this example the following was set:
Font Name: Arial Black 
Color: Black
Font Height: 14
Font Style: No selection was made.

Select alignment options. In this example both options were set as Center.

Select the following options as needed. In this example Auto Size is selected.

Word Wrap
Laser Engrave

PLT-01485, Rev. 2.5

September 2018

3.2.2 Add a text label (company name)
A text label prints the same on every card. There is no data entry or database that feeds into this field. For
this example a Company Name is added.

2.Click in the  pane to open and set the following:

1.Select Card Design application > Home tab > Text Label. 

Field
Text Label 

Card Display

Setting

Text Properties 

Font

Alignment

Options
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Enter a specific location for the label. The text box can be moved using drag/drop.

Select the following options as needed. In this example no options were selected.
Non-Printable Entry, Conditional, and Print on Fluorescing Panel

Select the following options as needed. In this example the following was set:

Border Color: Transparent
Border Width: 0
Fill Color: Transparent

23

3.Click and  tab > ). 

The data field adds a unique data field to the card record (i.e. employee number). See
application for information on populating the Data field.

1.Select Card Design application > Home tab > Data Field. 

Field
Placement

Printing

OK 

Setting

Save (File Save Template

3.2.3 Add a data field (employee number)
Section 4 Data Entry 

Border and
Fill
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Define the field name and enter the text to display in this field.
Note:The Field Name should be a name that can be associated to the actual field text. 

Field Name: Enter Employee Number
Field Type: Text
Field Options: This is a Mandatory Field

Set the font options. In this example the following was set:
Font Name: Arial 
Color: Black
Font Height: 10
Font Style: No selection was made.

Select alignment options. In this example Both options were set as Center.

Select the following options as needed. In this example the option Reduce to Fit is 
selected.
Leave whatever data is populated. The text box can be moved using drag/drop.

Select the following options as needed. In this example no options were selected.
Non-Printable Entry, Conditional, and Print on Fluorescing Panel

Select the following options as needed. In this example the following was set:

Border Color: Transparent
Border Width: 0
Fill Color: Transparent

PLT-01485, Rev. 2.5

September 2018

2.Click in the  pane to open , set the following:

Field
Data Field 

Card Display

Setting

Data Field Properties

Font

Alignment

Options

Placement

Printing

Border and
Fill
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Set the following Text Options: 
Default Value: Enter a default value (in this example we entered 
displays on all cards prior to any data entered during Data Entry.

Note:This field is not required.
Max Characters: 20
Min Characters: 0
Format: None

Source: Data Entry

No options selected.

No options selected.

No options selected.

). This 
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5.Click 

6.Click 

4.Set the following:

 to close the window.

to close the window. 

3.Click Advanced Data Field Options. 

Note:The Advanced Data Field Options window shown below is for a Data Field that has the Field 
Type of Text selected. For information on other Field Types Advanced Data Field Options, see 
the Asure ID Reference Guide Section 3 Card Design Application (PLT-01797). 

Field
Text Options

OK

OK 

Setting

Data Field Properties 

Data Source

Picklist

Data Formatting

Data Entry Options

HID Global - 
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8.Select  tab > 

7.The newly created Data Field can be positioned on the card, by simply selecting and dragging.

File Save Template.



September 2018

PLT-01485, Rev. 2.5 Card Design application

Define the field name and enter the text to display in this field.
Note:The Field Name should be a name that can be associated to the actual field text. 

Field Name: Enter Employee Dept.
Field Type: Text
Field Options: Do not select any options.

Set the font options. In this example the following is set:
Font Name: Arial 
Color: Black
Font Height: 10
Font Style: No selection was made.

Select alignment options. In this example Both options are set as Center.

Select the Reduce to Fit option.

27

3.2.4 Add a data field picklist (employee dept.)
The Data Field Picklist allows you to select a requirement from a list. See
information on populating the Data field.

2.Click in the Card Display pane to open 

1.Select Card Design application > Home tab > Data Field.

, set the following:

 for 

Field
Data Field 

Setting

Data Field Properties

Section 4 Data Entry application

Font

Alignment

Options
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Card Design application

Leave whatever data is populated. The text box can be moved using drag/drop.

Do not select any options.

Select the following options as needed. In this example the following was set:

Border Color: Transparent
Border Width: 0
Fill Color: Transparent

PLT-01485, Rev. 2.5

September 2018

3.Click Advanced Data Field Options. 

Note:The Advanced Data Field Options window shown below is for a Data Field that has the Field Type 
of Text selected. For information on other Field Types Advanced Data Field Options, see the 
Asure ID Reference Guide, Section 3 Card Design Application (PLT-01797) .

Field
Placement

Printing

Border and 
Fill

Setting
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Do not select any options.

Do not select any options.

 link.

Set the following Text Options: 
Default Value: <NULL>
Max Characters: 255
Min Characters: 0
Format: None

Source: Data Entry

Select the following options:
Use a picklist to select the value
Allow null picklist value

Card Design application
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5.Select the 

6.Click 

7. Enter 

4.Set the following:

Set the 

8.Repeat this process entering 

9.Click OK.

 and 

 into the field, and click 

 options first, to enable the correct 

 to the picklist.

 field.Note:

Field

Text Options

Picklist

Setting

Manage the Picklist

Add an Item. 

Human Resources

Engineering

OK.

Finance

Default Value

Data Source

Picklist

Data Formatting

Data Entry Options
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Note:

File Save Template.

Default Value

14.Select  tab > 

These new items now appear in the drop-down menu for the 

10.Click OK to close the Advanced Data Field Options window.

11.Click OK to close the Data Field Properties window

12.The picklist does not display in the Card Design Application.

13.Position the field on the card design area approximately where shown.

 field.
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Define the field name and enter the text to display in this field.
Note:The Field Name should be a name that can be associated to the actual field text. 

Field Name: Enter Full Name
Field Text: This field auto-populates after the data has been entered.

Click Insert Data Field to add data to the field.
Click Insert Existing Data Field to use a existing data field set up on the card template. 
Set the font options. In this example the following was set:

Font Name: Arial
Color: Black
Font Height: 10
Font Style: No selection was made.

Select alignment options. In this example Both options were set as Center.

Select the Reduce to Fit option.
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3.2.5 Compound field (last name, first name)
A Compound Field is useful when multiple data fields are to be aligned next to each other. An example of
using a Compound Field is placing a last name one space after the first name.

2.Click in the Card Display pane to open , set the following:

1.Select Card Design application > Home tab > Compound Field.

Field
Compound
Field

Setting

Compound Field Properties

Font

Actions

Alignment

Options
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Card Design application

Field Name: Enter First Name
Field Type: Text
Field Options: Do not select any options.

Set the following Text Options: 
Default Value: Leave blank.
Max Characters: 255
Min Characters: 0
Format: None

Source: Data Entry.
For information on adding a database source, see 

Leave whatever data is populated. The text box can be moved using drag/drop.

Do not select any options.

Select the following options as needed. In this example the following was set:

Border Color: Transparent
Border Width: 0
Fill Color: Transparent

PLT-01485, Rev. 2.5
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3. Select

4.Set the following on the window:

Field
Placement

Printing

Border and 
Fill

Field
Field 

Setting

 Insert Data Field.

Data Field Properties 

Setting

Data Source

Text Options

Section 4 Data Entry application.
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Do not select any options.

Do not select any options.

Options disabled.

Card Design application
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5.Click OK.

6.Repeat steps 3, 4, and 5 with the Field name entered as 

7.Enter a space between the first and second data fields, on the 
done, when the data is entered the two text fields are continuous.

 display pane. If this is not 

Field
Picklist

Data Formatting

Data Entry Options

Setting

Last Name. 

Field Text
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8.Click 

9.Select  tab > 

. Position the field on the card design area approximately where shown.

The native database for Asure ID has a size limitation of 2GB when using Microsoft Access (MS Access
limitation). Large photo files may cause the database to reach its limitation and prevent the addition of
records. It is recommended to place photos in a folder, and using a photo field in the template.

1.Select Card Design application > Home tab > Photo.

OK

File Save Template.

3.2.6 Add a photo
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Define the field name and select the format type of the graphic. 
Field Name: Enter Employee Photo
Format Type: .JPG
Select the Use a Folder Data Source option.

When the Use a Folder Data Source option is selected (in the step above), the 
in the top right, changes to the Folder Data Source.

Path: Select the path to where the photos are stored.
Key Field: Leave as Record ID (default). 

Note:Key fields are covered in Section 4 Data Entry application.

Select the Maintain Aspect Ratio option.

Leave whatever data is populated. The text box can be moved using drag/drop.

Do not select any options.

Select the following options as needed. In this example the following was set:

Border Color: Black
Border Width: 2
Rounded Corners: 0

35

 pane 

5.Select  tab > 

2.Click in the Card Display pane to open 

3.Click OK.

4.Position and size the photo field on the card.

, set the following:

Field
Image

File

Setting

Save Template.

Photo Properties

Options

Placement

Printing

Border and 
Fill

Folder Data
Source

Data Source
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Define the field name and select the format type of the graphic. Do not select the options.
Field Name: Enter Employee Signature
Format Type: .JPG

The Table and Field options are disabled. A signature tablet is used to add the employee 
signature.
Select the Maintain Aspect Ratio option.

Leave whatever data is populated. The text box can be moved using drag/drop.

Do not select any options.

Select the following options as needed. In this example the following was set:

Border Color: Transparent
Border Width: 0

PLT-01485, Rev. 2.5
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3.2.7 Add a signature
Adding a signature can either be done through a graphic stored in a folder or through a signature capture
device.

3.Click 

2.Click in the Card Display pane to open , set the following:

1.Select Card Design application > Home tab > Signature.

Field
Image

OK.

Setting

Signature Properties

Folder Data
Source

Options

Placement

Printing

Border and
Fill
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5.Select  tab > 

4.Position and size the signature field on the card.

File Save Template.
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Card Design application

Click Load new Image from file. Browse to locate the file.
The graphic appears in the Preview pane.
Note:If this is not the correct graphic or needs editing, select Edit Image.

Select the Maintain Aspect Ratio option.

Leave whatever data is populated. The text box can be moved using drag/drop.

Do not select any options.

Select the following options as needed. In this example the following was set:

Border Color: Transparent
Border Width: 0

Both options (Width and Height) should be left at 0.

PLT-01485, Rev. 2.5
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3.2.8 Add image (logo)
The image (such as a logo) displays on every card.

3.Click 

2.Click in the Card Display pane to open 

1.Select Card Design application > Home tab > 

, set the following:

Field
Image

OK.

Setting

Image.

Compound Field Properties

Rounded
Corners

Options

Placement

Printing

Border and 
Fill
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5.Select  tab > 

4.Position and size the image field on the card.

A background displays on every card. This can be customized as a solid color, sample background or you can
add your own background to the folder Asure ID > Images > Asure ID Backgrounds.

1.Select Card Design application > Home tab > Background.

Note:If the card is dual-sided, you can select which side to apply the background. You can also 
right-click on the card and select Add Background.

File Save Template.

3.2.9 Background
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Card Design application

Click Load new Image from file.
The graphic appears in the Preview pane.
Note:If this is not the correct graphic, or needs editing, select Edit Image.

Select the Maintain Aspect Ratio option.

Leave whatever data is populated. The text box can be moved using drag/drop.

Do not select any options.

Select the following options as needed. In this example the following was set:

Border Color: Transparent
Border Width: 0

Both options (Width and Height) should be left at 0.

PLT-01485, Rev. 2.5
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2.Select 

3.Set the following on the Background Properties window:

4.In this example we select a color background. From the Select a Color option, click the 
a color from the pull-down list. The color selection appears in the display window.

5.Click OK.

 tab. Select 

Field
Image

Setting

Add Background to Front of Card. 

Web

Rounded
Corners

Options

Placement

Printing

Border and 
Fill
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6.The background now displays on the card.

Building upon the basic card template, you can add options such as:

Shapes - See the Card Design section in the 
Application (PLT-01797), for information on adding shapes.

Barcode - See 

Magnetic Stripe - See 

Smart Chip - See 

Note:For information on the PACS Registration, Laser Writer, or 
(PLT-01797).

The basic card template is completed.

At this point you can edit any fields by double-clicking on the object and changing the properties in the 
dialog box.
Fields can also be freely moved by drag-and-drop or by changing the Placement properties window 
(displayed after double-clicking the object).
Resizing of an object can also be done by selecting and dragging by the handle to resize.

7.Select File tab > Save Template.

3.3 Advanced card design tutorial

Asure ID Reference Guide, Section 3 Card Design 

Section 3.3.1 Add a barcode

Section 3.3.2 Magnetic stripe (magstripe)

Section 3.3.3 Enable smart chips

Live Link, see the Asure ID Reference 
Guide, Section 3 Card Design Application
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3.3.1 Add a barcode

3.3.1.1 Barcode data tab
1.

Select application > 

Click in the Card Display pane to open 

tab > 

set the following on the  tab. 

Card Design Home Image.

Barcode Properties Data
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Select the Include Quiet Zones option. This leaves a white area around the barcode for
ease of reading.

Leave whatever data is populated. The text box can be moved using drag/drop.

Select the following options as needed. In this example the following was set:

Bar Color: Black
Fill Color: Transparent

Do not select any options.

Field Name: Enter Barcode.
Type: Leave the default Code 39. There are many options available from the drop-down 
list. See the Asure ID Reference Guide, Section 3 Card Design Application 
(PLT-01797), for information.
Test String: Leave the test string.
Font: Arial
Font Size: 12
Rotate (CCW): 0
Maintain Aspect Ratio: Select this option. 

Select Create a new Data Field. See Section 3.3.1.2 Create a barcode data field.

Select the Barcode Data field from the Available 
pane, and click Add to move to the Active pane.
Note:This can only be done after the Barcode 

Data field has been created in the field 
above.
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2.Click 

Field
Barcode

OK.

Setting

Printing

Quiet Zone

Create Fields

Select Fields

Placement

Bar and Fill Color
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Define the field name and enter the text to display in this field.
Note:The Field Name should be a name that can be associated to the actual field text. 

Field Name: Enter Barcode Data
Field Type: Numeric
Field Options: Do not select any options.

Set the font options. In this example the following was set:
Font Name: Arial 
Color: Black
Font Height: 12
Font Style: No selection was made.

Select alignment options. In this example Both options were set as Center.

Do not select any options.

Leave whatever data is populated. The text box can be moved using drag/drop.

Select the Non-Printable Entry option.

Select the following options as needed. In this example the following was set:

Border Color: Transparent
Border Width: 0
Fill Color: Transparent

PLT-01485, Rev. 2.5
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3.3.1.2 Create a barcode data field
1.

2.The 

Select 

3.Set the following on the  window.

. This is the information coded into the barcode. 

window opens.

Field
Data Field 

Create a New Data Field

Data Field Properties

Data Field Properties

Setting

Font

Alignment

Options

Placement

Printing

Border and 
Fill
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4.Click 
the 

4.Select 

1.

2.Click 

Select the 

.

 tab > 

. You are returned to the 
> Available pane.

. option.

3.Position the barcode field on the card design area.

 window, and this newly created field is listed on 

File

OK
Select Fields

Show Barcode Text

OK

Save Template.

Barcode Properties

3.3.1.3 Barcode options tab
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Select the ISO option.

Select the Place Magstripe at card bottom.

Create a new Data Field.

Click Create a new Data Field. See 

Select the Magstripe Data field from the Available 
pane, and click Add to move to the Active pane.
Note:This can only be done after the Magstripe Data 

field has been created in the field above.

PLT-01485, Rev. 2.5
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3.3.2 Magnetic stripe (magstripe)
The Magstripe option is located on the Card Setup tab.

The magstripe is located on the back side of this card template. The default position is the top of the card.

2.On the 

3.On the tab click 

 application > 

 tab set the following:

tab > 

Track 2 

Field

Create Fields

Select Fields

To Add a Magstripe:

1. Select the Card Design

Magstripe

Field 

Type

Options

Setting

Setting

Card Setup Magstripe. 

Section 3.3.2.1 Create a magstripe data field.
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Field Name: Enter Magstripe Data
Field Type: Text
Field Options: This is a Unique Field

Set the font options. In this example the following was set:
Font Name: Arial 
Color: Black
Font Height: 10
Font Style: No selection was made.

Do not select any options.

Do not select any options.

Leave whatever data is populated. The text box can be moved using drag/drop.

Select the Non-Printable Entry option.

Select the following options as needed. In this example the following was set:

Border Color: Transparent
Border Width: 0
Fill Color: Transparent
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3.3.2.1 Create a magstripe data field
1.

2.Click 

Set the following on the  window.

. The magstripe is added to the bottom of the back of the card.

Field
Data Field 

OK

Setting

Data Field Properties

Font

Alignment

Options

Placement

Printing

Border and 
Fill
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Card Type: Select the card type from the pull-down list.
Note:If the reader is connected, select Auto Detect. For this example, leave the default 

(2K1).

Click Add an Application.

No settings for this option.

PLT-01485, Rev. 2.5
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3.3.3 Enable smart chips
Cards listed under the Enable Smart Chips option, have a smart chip embedded in the card.

Note:The Smart Chip is not visible on the card template.

For enabling other types of smart chips other than what is shown in this example, see the 
Guide, Section 3 Card Design Application (PLT-01797).
The Card Properties pane shows any applications added. This section is only covering using iDIRECTOR® to 
enable an iCLASS® smart chip for a read application. 
To Enable a Smart Chip:

2.The 

 application > 

 dialog box opens. 

 tab >  >  > 

Field
Configuration

1. Select the Card Design

Setting

iCLASS Chip Properties

Card Setup Enable Smart Chips IDirector iCLASS.

Asure ID Reference 

Actions

Properties
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3.3.3.1 iDIRECTOR wizard 
The iDIRECTOR® wizard allows you to add an iCLASS® application.

2.Select the 

3.Click .

1.On the welcome window click Next.

application. 

4.Select the H10301 (Std 26 Bit) Format Type.

Note:This configuration cannot be changed after the wizard is completed. If the application needs to 
be modified, you must delete the existing application, then add a new one.

HID Access Control Application (Read) 

Next
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5.Click 

6.Select the Create a Data Field for each iDIRECTOR Field option for this example.

Create a Data Field for each iDIRECTOR Field option:

Disabled: To read HID Access Control Application information and write it to an external data 
source. 
Enabled: Asure ID creates a data field for the Facility Code and Card ID Number to be stored 
within the Asure ID native database.

7.Click Finish.

Next.
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8.A new tab with the new application is added. 
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9.The advanced card template is completed.
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4Data Entry application

4.1 Data Entry overview
The Data Entry application allows you to populate the database created in Card Design with the appropriate
data for the card, and print the designated cards. 

Note:The Asure ID® Solo edition is limited to 200 records. 

The Data Entry application has the following tabs, with a corresponding toolbar.

File: The File tab allows you quick access to open a template or data group, printing, encoding and 
Laser writer access.
Home: The Home tab allows the configuration of data input, photo and signature acquisition, and 
record finding/filtering options.
Database: This tab groups import/export and record archive, restore, refresh options.

View: This tab groups the views of current records and record layout options.

Advanced: This tab groups laser controls, encoding, and PACS Integration. 
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4.2 Data Entry Home tab
The  

 application >  tab > 

 tab contains the basic tools to create a data field. See the 
(PLT-01797) for detailed information on these tools.

Records can be added individually or in a batch. To add more than one record at a time, select 
input the number of records to add. The window displays these as blank records. 

Note:This option cannot be used if:

The data field is linked with Live Link.

There are mandatory entries on the template.

 and 

Data EntryHome

Add a Single Record:

1. Select the Data Entry Home Add.

Add Batch

Section 4 Data Entry Application
Asure ID Reference Guide, 

4.2.1 Add a record with data, photo, and image fields
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Enter JDoe 12.
Note:The red star indicates the field is required.

Select Engineering from the pull-down list.

Enter Jane.

Enter Doe.
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4.To add an Employee Photo:

a.Right-click on the Employee Photo area and select Load from File. 

Note:Alternatively you can select the Load from File option from the toolbar.

b.Browse and select the employee image file.

c.Crop the photo as needed in the Edit Image window, and click OK.

Note:To re-open the Edit Image window, double-click on the image.

2.A new, empty record is displayed. 

Note:The data fields that were added when designing the card template are listed on this new record, 
ready for the entering information. 

3.Enter the following information:

Field
Employee Number

Information

Employee Dept.

First Name

Last Name
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d.The 

6.Click Barcode Data and type 123456 into the text field.

7.Click Magstripe Data and type 12345678 into the text field. 

Note:For Track 2 data requirements, see the 

5.To add an Employee Signature:

a.Right-click in the Employee_Signature area and select 

b.You need to use the signature pad for capturing the signature.

c.Click OK.

 (PLT-01797).

 option opens a window that allows you to modify the image for best results.Effects

Capture Signature.

Asure ID Reference Guide
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8.Click  group. When the 
pane. 

9.To see an enlarged version you can double-click on the preview.

 button is selected, the card previews in the 

When this card is viewed in the enlarged preview, it is noticeable that the alignment of fields is visually not
the best. This is where using the edit tools in the card design comes in handy.

Editing can be done at this stage by returning to the Card Design application and moving fields into better 
positions. 
Note:The Facility_Code and Card_ID_Number cannot be edited.

Save within the Records
Preview and Filter Manager

Save
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4.3 Data Entry Database tab
The following section covers the Data Entry application 

2.The 

3.On the 

 opens. Click 

 window, select 

tab > 

database and records see the 
 tab. For additional information on the 

(PLT-01797).

Record information can be Imported from a MS Access database, SQL Server database, Oracle database,
Excel, or a comma-separated values (CSV) file.
Import record information from a CSV file

Import/Restore Wizard

Choose Import Source

1. Select Data Entry application > Database 

Next.

Database

Import Wizard.

Comma Separated Values.

Asure ID Reference Guide, Section 5 Databases

4.3.1 Import/export
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4.Click 

5.On the 

Click 

Select the 

Specify the 

6.Click Next.

 window set the following:

 to locate and select the database to be imported.

 option, if this applies.

Next.

CSV Import Source

Browse

Contains Header Row

Delimiter in the file.
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8.Select a Field from the 
are no duplicates.

Below is an example of the CSV file.

 and click 

7.On the Field Links window, to map the data fields:

a.Select a Import Source Field, and then the corresponding 

b.Click Add.

 to link.

. A unique field separates each record so there Field Links Mark Unique

Template Field
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10.Click 

11.On the 

12.Click Next.

13.Click Begin Import to update existing records. 

Note:As the update is performed, the log is displayed in the window.

 on the Wizard Field Links page.

 window, select the Update existing records and import new records option.

9.To import a image:

a.Select a Image Field.

b.Click Image File Import.

c.Click Browse to locate and select the image file to be imported.

d.Select the Column Containing File Reference option, if this applies.

e.Specify the image File Type.

Note:Importing an image file in this manner removes any preexisting photo links into the wizard. When 

importing a CSV source, photos need to be retrieved from an external folder.

Next

Import Options
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14.Click when complete.

15.The import is complete. Click Finish.

Note:The Data Entry records are added/updated with these changes.

Next 
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4.4 Data Entry View tab
The Data Entry View tab, contains all the tools to customize the views, including customizing the record
layout. For detailed information on the View tab, see the Asure ID Reference Guide, Section 4 Data Entry
Application (PLT-01797)

Records can be viewed as a single/multiple view or in a table format.
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4.5 Data Entry Advanced tab
The Data Entry Advanced tab, contains the advanced options that may be installed on the printer. If the
options are not installed they are grayed out. 

Advanced options are:

Laser Controls

Encoding

PACS Integration

For detailed information on these options see the 
(PLT-01797). 

Asure ID Reference Guide, Section 4 Data Entry Application 
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5Reports Application
The Reports Application provides you with preformatted reports of application operation. Reports can also
customize in terms of layout, columns, and filters, which can be saved for future use. 

 This report contains all users, capabilities, and general information.

 This report contains all the detailed user activities. 

This report contains all user login activity.

This report lists all the current templates. 

This report lists the data fields for a selected template. 

Right-click on any column heading in a report, for additional Column options. for more options.
Columns can be rearranged or removed as required. 

This report contains all records (and associated data fields) for a selected 
template.
Records with no Photos: 
for a selected template. 

This report contains all records (and associated data fields without photos) 

This report contains all records that have not been printed, for a selected template.

 This report contains all voided records for a selected template. 

This report contains all user activity for all templates.

Thisreport contains history of all reports printed.

User List:

User Activity:

User Login:

Template List:

Data Fields for Template:

Note:

All Records for a Template:

Unprinted Records:

Voided Records:

Template History: 

Print History Report: 

5.1 User Reports

5.2 Data Entry Reports

5.3 Card Design Reports
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5.4 Create a report 
The following is the general process for creating a report.

1.Select Reports application > Home tab > 

4.The report is displayed. This example is the All Records for a template. 

2.Select a template to run the report on. 

Note:This option is only required when needing Record or data entry field information (i.e. Data Entry 
Reports, or Data Fields for Template report.

3.Click OK.

All Records for a Template.
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5.5 Custom report
A custom report is any report that you have run, that you have changed the layout (columns, sorting, etc.) To
be able to reuse this report configuration the file can be saved for future use. 

2.Name the report and select

3.Click OK.

4.The saved report is displayed under the  tab.

1.After the report has been modified, select Save Custom Report from the toolbar.

Create Private Report.

Custom Reports
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5.6 Export reports
Reports can be exported in the following file types:

1.One a report has been run. Select 

PDF

XLS

RTF

 from the toolbar.

2.Name and save the file.

The following example is a user record report exported to XLS (Excel file).

To export a report

Export
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6iCLASS SE Encoder application

6.1 Overview
The iCLASS SE® Encoder application is used to encode HID Prox® and read/write applications onto smart
cards.

The following matrix illustrates the supported capabilities and card types.

* Only supported for SIO PACS Applications

6.1.1 Credential credit management
All transactions are enabled by credential credits. These are individual credits that are used with every
transaction until there are none or until additional credits are ordered and applied to the encoder. For
information about ordering credentials, see the HID Global Credential Programmer How to Order Guide,
which can be found on www.hidglobal.com.

Program HID Access Control Application Custom Data

Standard PACS 
Application

�

SIO PACS 
Application

Supported Key Types Standard 
Application

SIO
Application

Supported
Key Types

HID Prox cards and
fobs

iCLASS®

iCLASS SR

iCLASS SE

iCLASS Seos®

MIFARE Classic 
(not Indala Flexsmart)
MIFARE DESFire EV1

N/A

N/A

N/A

�

N/A

N/A

�

�

�

�

�

N/A

Standard/Elite/Custom

Standard/Elite/Custom

Standard/Elite/Custom

Standard/Elite/Custom

Standard/Elite*/Custom
*

Standard/Elite*/Custom

N/A N/A

Coming Soon

N/A

�

�

�

�

�

�

�

�

http://www.hidglobal.com/
http://www.hidglobal.com/
http://www.hidglobal.com/documents
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6.2 iCLASS SE® Encoder application modules
The iCLASS SE Encoder application contains three modules. 

The Reader Configuration window is used to create the Reader Data configuration cards (for both keys and
reader limited settings) The application allows you to change the keys or behavior of a Reader. 

The Work Order Manager module allows you to define and save an encoding profile for a credential
deployment. Each Work Order defines the number of data fields encoded, as well as the data type and field
size. These data fields are concatenated into a single data stream and encoded into an application, and are
defined by the selected format.

A Work Order is comprised of one or many Work Instructions. A Work Instructions is a single command 
issued during work order execution. The single work instruction can either read or write to a specific memory 
location.

6.2.2 Key Management module
The Key Management module of the iCLASS SE Encoder allows you to view and manage the HID and Custom
Keys. See the Asure ID Reference Guide, Section 7 iCLASS SE Encoder application (PLT-01797) module for
information on creating custom keys.

Note:Standard Keys and Key Sets are pre-loaded with the Encoder Configuration Package included on the 

USB stick. 

6.2.1 Work Order Manager module

6.2.3 Reader Configuration module
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6.3 Set up the iCLASS SE encoder 
6.3.1 Load the configuration package
Initially you receive the Credential Credits and 

2.Browse to locate the 

3.Select the file and click 

USB stick or in an email. To upload this package:

1. Select iCLASS SE Encoder application > 
Configuration Package. 

 from HID.

 either through a configuration package included on the 

module > File tab > Upload 

Configuration Package

Open.

Keys

Work Order Manager 
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4.A confirmation message is displayed at the bottom of the window and the Credential Credits are 
displayed in the Configuration pane.

Note:Keys may also be loaded, depending on what was ordered.

The iCLASS SE Encoder includes a format interpreter capable of parsing all open and custom formats
developed and maintained by HID Global.

Format fields are presented to you in the desktop UI for the purpose of assigning data to each field.

Formats must be ordered from Customer Service. Most formats are custom to a specific OEM or end user, and
are not freely distributed.

The H10301 is the default format delivered with the application.

To use a format other than the provided default format.

1.Select iCLASS SE Encoder application > Work Order Manager module > File tab > Install Formats. 

2.Browse to locate the Format file from HID. Select the file and click Open.

3.After the format is successfully loaded, the new format is displayed as an option when creating a Work 
Order.

6.3.2 Install format
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6.3.3 Create a work order
A Work Order is comprised of one or many Work Instructions. A Work Instruction is a single command
issued during work order execution. The single work instruction can either read or write to a specific memory
location. 

See Section 6.4 Use case 1: deploy standard security credentials or Section 6.5 Use case 2: deploy HID Prox 
credentials for two common Use Case scenarios. For detail information on all Work Order configurations, see 
the Asure ID Reference Guide.

6.4.1 Create a work order to encode iCLASS credentials
Create a new work order for iCLASS credentials
Creating a new work order begins the definition of a work instruction through a technology specific wizard
plugin exposing many user selectable options.

1.Select iCLASS SE Encoder application > Work Order Manager module > New.

2.Select the iCLASS plugin and click OK.

This use case addresses the deployment of the legacy HID Access Control Application on iCLASS credentials.
This application is the predominant application in use in the market for the last decade. The use case also
addresses the lesser used legacy HID MIFARE application.

Note:The procedures in this use case assume readers are already configured with standard security keys for 
iCLASS and MIFARE SIO and have the iCLASS and MIFARE SIO data model interpreters. 

Note:For more detailed information, see the Asure ID Reference Manual.

6.4 Use case 1: deploy standard security credentials
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3.The wizard opens. Click 

4.Set the options on the Select data format page. This page shows options to set up the instruction. 

In this use case we are selecting:

 Write

 HID Access Application

No selection

HID Access Application

iCLASS Encoding 

Instruction Type:

Data Type:

Options: 

Credential Type:

Format: H10301 

Next.
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The name field displays the names of the format parameters as assigned by HID. It is
strongly recommended to leave these names as they are.

This field identifies the rules regarding how the value of a parameter is derived. 
These are read from the format file and there is typically no need to change.
This parameter type means every encoded credential has the value of the Default 
Value field for that parameter.
This parameter type starts with the value of the Default Value field and allows you 
to enter a new number.
This field ensures that a number can never be repeated. For best practice, it is 
recommended to keep this checked for the Card ID Number.
This field only has meaning for the Static and Manual User Entry parameter types. 
Auto Increment parameter type uses the Auto Number Range field.
This field determines the step for format parameters that are of the Auto Increment 
parameter type.
This field shows the allowable numbers that can be encoded for Auto Increment 
parameter Types. In the case of the H10301 format, the Card ID Number is open and 
untracked. This means all numbers for that parameter (16-bit number) are available. 
However, all Corporate 1k, proprietary, and open-managed formats have a Card ID 
parameter with a number range set in the format file that is determined when 
ordering the format.

6.Set the options on the page.

5.Set the options on the Define Format Parameters page.

This page exposes options to customize the selected format. In this use case we are seeing the details 
of the H10301 format, which is the open, 26-bit SIA Wiegand format. 

Field/Column
Name

Description

Memory Map Configuration 

Static

Default Value

Increment Step

Parameter Type

Manual User Entry

Auto Number Range

Enforce Unique Numbers
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This page shows options to set the memory configuration of the iCLASS card.

In this use case we are using Standard security media keys. Elite or Custom media keys (if they are
loaded) are also selectable at this step. 

8.Finish the wizard and save the Work Order.

Typically, encoding of iCLASS credentials is done with pre-configured credentials from HID (2k, 16x2k,
etc.). In which case, the Expected Card Type is Configured and there are no further selections to make. 

In some rare use cases, the encoder can be used to configure a virgin iCLASS credential. In this case the 
Expected Card Type is set to Unconfigured and the Card Configuration must be selected from the 
supported list and match the credential type used.

7.Set the options on the Key Selection page.

This page exposes options to select the media keys used to authenticate with the HID Application on 
the iCLASS credential. 
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6.4.2 Encode iCLASS credentials
1.When the work instruction(s) are executed, a message displays at the window bottom, the credential 

serial number displays in the main pane, and a new record becomes available for execution.

2.Open the iCLASS work order to encode from. Select Open from the toolbar, and select the Work Order 
from the list.
The work order table view shows the first credential ready to be encoded with a Card ID Number value 
of 1 and a Facility Code of 1.

In this case, the selected format for the work order is H10301. The Facility Code is a static parameter and
we set a default of 1 in the Work Instruction wizard. Every credential is encoded with the value of 1 for
this parameter. The Card ID Number is Auto Increment and increases by one every time a credential is
encoded. 

3.Select the record and select Execute Selected from the toolbar.

4.A status window provides feedback on the progress of the encoding operation.
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5.After the encoding operation is complete, the work order table view is updated with the
Number and a new record is created with the next Card ID Number.

 Card Serial 
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6.4.3 Create a work order to encode MIFARE classic credentials
Create a new work order for MIFARE classic credentials

1.Select iCLASS SE Encoder application > Work Order Manager

2.Select the MIFARE Classic plugin and click OK.

New. module > 

Creating a new work order begins the definition of one work instruction through a technology specific
wizard plugin exposing many user selectable options.

3.The MIFARE Classic Encoding wizard opens. Click Next.
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5.Set the options on the 
, Step 5. 

 page. See 

4.Set the options on the Select Data Format page.

This page exposes options to set up the instruction. In this use case we are selecting:

 Write

 HID Access Application

No selection

HID Access Application 

Instruction Type:

Data Type:

Options: 

Credential Type:

Format: H10301 

Define Format Parameters
encode iCLASS credentials

Section 6.4.1 Create a work order to 
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6.Click Next on the Key Selection page. 

Note:Sector number and keys used for authentication are fixed and not selectable.

7.Finish the wizard and save the instruction profile.

1.When the work instruction(s) are executed, a message displays at the window bottom, the card serial 
number displays in the main pane, and a new record becomes available for execution.

2.Open the MIFARE Classic work order to encode from. Select Open from the toolbar, and select the 
Work Order from the list.
The work order table view shows the first credential ready to be encoded with a Card ID Number value 
of 1 and a Facility Code of 1.

In this case, the selected format for the work order is H10301. The Facility Code is a static parameter and
we set a default of 1 in the Work Instruction wizard. Every credential is encoded with the value of 1 for
this parameter. The Card ID Number is Auto Increment and increases by one every time a credential is
encoded. Select the record and select Execute Selected from the toolbar.

3.A status window provides feedback on the progress of the encoding operation.

6.4.4 Encode MIFARE credentials
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4.After the encoding operation is complete, the work order table view is updated with the 
Number and a new record is created with the next Card ID Number.

Card Serial 
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6.5 Use case 2: deploy HID Prox credentials
This use case addresses the deployment of HID Prox cards and fobs. 

6.5.1 Create a work order to encode HID Prox credentials

1. Select 

2.Select the 

 application > 

plugin and click OK.

 module > 

Creating a new work order begins the definition of a work instruction through a technology specific
wizard plugin exposing many user selectable options.

iCLASS SE Encoder

Prox 

Work Order Manager New.
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3.The 

5.Set the options on the 
, Step 5.

wizard opens. Click 

 page. See 

4.Set the options on the Select Data Format page.

This page exposes options to set up the instruction. In this use case we are selecting the H10301 as the 
Format.
In this use case we are selecting:

Instruction Type: Write

Options: No selection

Format: H10301

Prox Encoding Next.

Define Format Parameters
encode iCLASS credentials

Section 6.4.1 Create a work order to 
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6.Finish the wizard and save the instruction profile.

This page exposes options to customize the selected format. In this use case we are seeing the details
of the H10301 format, which is the open, 26-bit SIA Wiegand format.
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6.5.2 Encode HID Prox credentials
1.Open the Prox work order to encode from. Select Open from the toolbar, and select the Work Order 

from the list.

The work order table view shows the first credential ready to be encoded with a Card ID Number value 
of 1 and a Facility Code of 1.

In this case, the selected format for the work order is H10301. The Facility Code is a static parameter and
we set a default of 1 in the Work Instruction wizard. Every card is encoded with the value of 1 for this
parameter. The Card ID Number is Auto Increment and increases by one every time a card is encoded. 

2.Select the record and select Execute Selected from the toolbar.

3.A status window provides feedback on the progress of the encoding operation.
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4.After the encoding operation is complete, the work order table view is updated with the 
Number and a new record is created with the next Card ID Number.

Card Serial 
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7Advanced application
The Advanced Application is used to manage Users and Laser Printer configurations.

Note:This section covers the basics of the User Config module. For detailed information on the entire 

Advanced Application, see the Asure ID Reference Guide.
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7.1 User config module
With the Data Entry application, the Asure ID admin user imports/enters the user information. The Advanced
Application allows the Asure ID admin to manage these records.

See Section 4 Data Entry application for detailed information.

1.Select the Advanced application > User Config module > Home tab > Add User.

2.Enter the user information in the blank record. 

Note:Fields become active when the cursor is passed over them. 

3.Select the options for this user to have access to. In this example , 
Reports have been selected.

4.In the Data Entry drop-down list, select .

5.In the iCLASS SE drop-down list, select .

6.Select Save Users from the toolbar. This saves all users that have been modified.

, and 

7.1.1 Add a user

Card DesignCard Printing

Read/Write Access (no PACS)

Operator
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7.1.3 Remove a user

7.1.2 Modify and save a user

1.Select the Advanced application > User Config module > Home tab.

2.Select a user.

3.Select Remove User from the toolbar, and click Yes to confirm.

1.Select the Advanced application > User Config module > Home tab.

2.Select and modify one or more users as needed.

3.Select Save Users from the toolbar. This saves all users that have been modified.
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7.1.5 Add a user group

7.1.4 Change a user password
1. Select a user record.

2.Select Change Password from the toolbar.

3.In the pop-up dialog box, type in the new password and confirm.

4.Click OK.

1.Select the Advanced application > User Config module > Home tab >

2.In the Manage Group window, select the Add User Group icon.

3.Enter the group information in the blank record. 

Note:The field becomes active when the cursor is passed over it.

4.Select the options for this group to have access to. In this example 
Reports are selected.

5.In the Data Entry drop-down list, select .

6.In the iCLASS SE drop-down list, select .

, and 

Manage Group.

Card Design, Card Printing

Read/Write Access (no PACS)

Operator
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7. Select the  icon. This saves the user group. Save
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7.1.6 Delete a user group
1.Select the Advanced application > User Config module > Home tab > 

2.In the Manage Group window, select the group to delete and select the 

3.In the Warning pop-up dialog box, click Yes to delete the user group. 

.

 icon.

Manage Group

Delete Group
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7.1.7 Assign a template to a group
1.Select the Advanced application > User Config module > Home tab > Assign Template to Group.

2.In the Assign Template To Group window, select the group to assign the template to. In this example, 
Operator PACS.

3.Select the template type to filter (card templates, work orders or all). In this example Asure ID Card 
Template is selected.

4.Click the arrow key to move the selected Available Template column to the Assign Template column. 
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